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Chapter 1
Getting Started

Using this Guide

This help system is your primary reference for KeyCollect 4.0, including:

• KeyCollect concepts 

• Data entry instructions 

• Dialog box and menu reference

Both the printed (Adobe Acrobat PDF) version of the guide and the Help 
system contain the same information.

Additional Resources

Discussion List and 
Newsletter

Apian provides a free discussion list for users to ask questions about 
SurveyPro and survey research in general. You can opt for either an e-
mail or Web-based interface. 

We also recommend signing up for the Apian newsletter to stay posted on 
product updates and workshops, and for the tips from our Support team.

http://apian.com/support/forum/

Knowledge Base This is a searchable resource for how-to questions and problem-solving. 

http://apian.com/support/knowledgebase/

Technical Support All new orders and upgrades come with a period of free support. Both 
per-incident contacts and annual support contracts may be purchased by 
phone at (800) 237-4565 or online. 

http://apian.com/support/ (206) 547-8392

Coaching and Training Apian offers public workshops, on-site corporate training, and one-on-one 
telephone coaching. 

http://apian.com/training/
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Downloads Updates (patches) to SurveyPro and NetCollect are provided for you to 
download free of charge.

http://apian.com/downloads/

Installing KeyCollect

KeyCollect’s installation is a straightforward process, similar to other Win-
dows applications.

1. On the system where SurveyPro is installed, locate the KeyCollect installation 
file—usually at:
C:\Program Files\Apian Software\SurveyPro 40\Install Accessories\

2. Copy the install program to the system or LAN server on which you want 
KeyCollect

3. Make sure to have your SurveyPro 4.0 serial number available and run the 
install program

Each installation of KeyCollect will support 10 concurrent users. How-
ever, there is no limit to the number of data entry stations you can set up, 
so if you need additional users simply install another copy.

Database Fundamentals

If you're new to databases, here are some concepts and terms which will 
help you understand the KeyCollect documentation.

Form = Record = 
Respondent

In your KeyCollect file, each respondent (unless they've answered several 
times) is represented by one form in the database. That respondent's form 
includes all the information they've submitted.

Field = Question When you're designing your survey, each question you add creates a field 
in the database. This field definition includes information on the values it 
can accept, such as numeric, date, written, or multiple answer checkbox. 
In some cases, a single question tile will actually add several fields, such 
as with grids, or checkbox scales with Other blanks.

Database vs. Data File These two terms crop up when you get into import and export, and unfor-
tunately the lines are somewhat blurry. In that context, a data file (such as 
delimited ASCII) consists of the respondents' answers. A database will 
include the respondents' answers as well as definitions of the fields 
(numeric, text, etc.).
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Form ID Each form in your KeyCollect database includes a unique Form ID such 
as 9c46-03cm-1fc. This ID is created when each response is completed 
when a form is created in KeyCollect or another SurveyPro program. If 
you are importing files from another source, the ID will be generated on 
import. The IDs are designed to be unique, combining the date and time 
of the submission with other variables for almost no chance of duplica-
tion.
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Chapter 2
Menus

This chapter includes an overview of the different menu items, as well as 
the common dialog controls used within KeyCollect (see page 7). 

Menus

KeyCollect’s menus are:

File Common Windows file functions, such as print, save, and most recent 
files. See the next section.

Edit Cut, copy, paste, and other functions. See page 5.

View Preferences for which screen elements to display and how. See page 5.

Form Navigate among forms. See page 5.

Database Functions for changing many forms at once. See page 6.

Tools Utilities and preferences. See page 6.

Help Access to the Help system, which contains the complete manual content. 
See page 6.

File Menu

Here you’ll find common Windows file functions, such as print, save, and 
most recent files.

Open | Ctrl+O Opens an existing SDE data file.

New From Template Starts a new SDE data file from a SDT template.

Print with Data Allows you to print the forms filled in with all or some of the data. This is 
useful for “mail merges” of address information or ID barcodes, or for 
looking at individual responses in the context of the survey. See page 28.

Recent File List Lists recently accessed files.
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Exit | Alt+F4 Closes the current file (prompting to save changes), and exits KeyCollect.

Edit Menu

Editing responses within forms as well as some data entry preferences.

Cut | Ctrl+X
Copy | Ctrl+C
Paste | Ctrl+V

Standard Windows functions for cutting, copying or pasting the selected 
text. This can be used to copy and paste text between KeyCollect and 
other applications, as well as within or between KeyCollect projects.

Delete | Del Clears the current answer.

Copy Last Form's Answer | 
F7
Copy Last Form | Ctrl+F7

Copies either the answer from the same question in the previous form, or 
the entire contents of the last form—in either case, overwriting the cur-
rent answers. If you are doing this frequently to copy session or batched 
answers, you can also use the View menu's Master form to pre-load 
answers in each new form.

Auto Increments Specify number questions and have them automatically increment by one 
with each new form.

Protect Answers Prevents accidental changes to forms in the database. See page 27.

New Form Questionnaire In a multiple questionnaire project, changes the document used for add-
ing forms to the database. See page 11.

View Menu

Zoom Adjusts the display size of the document.

Preload Answers Preloads some of the answers in new forms for batch entry of responses. 
When you switch to the Preload mode the screen looks normal except 
that the form number will say “PRELOAD.” Enter whichever answers you 
want to preset (during entry answers can be changed for exceptions). 
Select the Forms, Preload menu item again to switch back to normal 
entry. See also the Edit menu's Copy Last Form's Answer and Copy Last 
Form.

Form Menu

Next Form | F10 
Last Form | F9 

Step forward and back through the forms. When you reach the last form, 
F10 will add a new one.

Find Form Select 
Find Same Answers 
Find Duplicates

A set of tools for navigating and cleaning the forms and the database. 
Each one pops up a small palette which lists forms matching a Form 
Select, the response of the current question, or is a duplicate. Within the 
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palettes, click on a form number to jump to that record, or Refresh to 
update the list when you make changes to your criteria or the data. See 
Understanding Data Cleaning on page 15.

Delete Form | Ctrl+F11
Void Form | Ctrl+F12

With Delete, the form is completely removes, which renumbers the forms 
after it in the database. Void leaves a placeholder to maintain form num-
bering, but also eliminates the form's data. See also Mass Delete on page 
22.

Database Menu

Mass Delete Deletes forms matching a Form Select, within a range of form numbers, 
or for the entire database. See page 22.

Mass Replace Replaces the response to a question based on a Form Select, within a 
range of form numbers, or for the entire database. See page 21.

Answer Replace Replaces one particular answer to a question with another—a quick way 
to consistently code short written answers. See page 19.

Fill Passwords Seeds forms in the database with a password value, for use with mail 
merges or other notifications. See page 28.

Tools Menu

Spell Check | F7 Checks spelling for responses in the current question, form or the entire 
database. See page 18.

Spelling Options Allows you to control what the spell checker should ignore, edit your cus-
tom dictionary, and activate the legal and medical supplements.

Refresh Answer Lists Forces an update of the Answer list in the left panel. To speed perfor-
mance, KeyCollect updates this list with new entries instantly, but only 
removes deletions on Refresh or Save.

Data Cleaning Similar to the import cleaning screen, this allows you to clean the con-
tents of your database, checking for required fields and pattern matches. 
See page 16.

Options Preferences for both the current file and for your system. See page 23.

Help Menu

Contents or Index Jumps to the contents of the Help system.

About KeyCollect Displays the version, serial number, license, and legal notices.
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Common Dialog Controls

Within the KeyCollect dialogs you'll see these buttons used many times, 
always with the same function.

Some or all of these buttons appear whenever a named object, such as a 
Form Select Filter, is used in a dialog. 

 Insert Insert is used to add a new object.

 Modify Modify edits the object (updating all dialogs referencing/using it)

 Delete Delete removes an object. 

 Duplicate Buttons Duplicate allows you to create a new object starting with the settings of 
the currently selected item.
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Chapter 3
Entering New Forms

Data entry has been optimized for both the mouse and keyboard, includ-
ing features such as single keystroke entry for shorter checkbox and rating 
scales. 

To Enter Responses

While the data entry screen shows an image of the questionnaire, it is 
only used as a reference. The actual entry and editing of a response 
occurs in the panel on the left hand side (see image below).

1. File, Open an existing SDE data file, or File, New from Template to create a file 
from a SDT.

2. Select a question on the right-hand side by Tabbing or clicking until you see 
an orange outline on the one you want.

3. Click an answer in the list, or type an answer based on the prompt line's 
reminder of the format.

4. Repeat 2 & 3 until you reach the end of the form, press F10 for the next form, 
and repeat!
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There are of course some additional nuances, as covered here and in Data 
Entry by Scale Type on page 10, but that's essentially how KeyCollect 
works. See also Understanding Data Cleaning on page 15.

Moving from field to field To move the highlight from question to question, you can use the mouse, 
Tab/Shift+Tab, or Enter keys. The only time Enter does not work is when 
you are editing a long written answer.

Moving from form to form At the top of the left panel is the current form’s number and two buttons 
for stepping back and forward one form at a time. F9 and F10 move back 
and forward through forms as well. Below the buttons is a field for typing 
in a form number for a direct jump. In addition to these basics, there are a 
number of “Find” functions under the Form menu.

Tools, Options dialog The first tab of the Options dialog (see page 23) includes two settings to 
streamline data entry. The first, Do not require Enter key on single-digits, 
means that when a checkbox or rating has less than 10 items, one 
numeric keystroke will mark the response and drop you to the next ques-
tion. The second, Go to next form after last question answered eliminates 
the need for clicking next or pressing F10.

Pre-loading answers Under the View menu is a Preload option which lets you set the initial val-
ues in a new form. When you select Preload, the form number in the 
upper left changes to indicate you’re entering initial values. When you’re 
finished, select View, Preload again to resume normal entry. This is pri-
marily used for batch entry or session information, where a number of 
forms share common answers, but is easy enough to change that it can be 
practical for even small batches. 
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Copying answers from other 
forms

The Edit menu includes two commands for copying responses from the 
previous form. Copy and paste can also be used to paste text into the 
entry box.

Spell check Spell checking may be applied to written answers in a single response, a 
form, or the entire database. See page 18.

Data Entry by Scale Type

Depending on the current question’s scale, you will need to enter the 
answer in a particular format. Just above the type-in box is a prompt line 
which will remind you of the scale type.

Single answer checkboxes, 
Ratings and Rankings

Type the number of the response or double-click on an answer in the list. 
You don’t need to enter the complete label.

Multiple answer checkboxes Type one or more numbers to indicate the box or boxes checked. As each 
checkbox number is entered, a highlight will appear in the Answers list. 
Numbers may be separated by spaces, commas, periods, plus +, minus -, 
or slash / keys. For mouse entry, click on the first answer you’re marking, 
then Shift+click for sequential entries or Ctrl+click to turn on and off non-
sequential items.

Number scales Enter the number value without any “$,” “%” or other symbols. The 
Answers list will also display existing responses which you can click to 
select.

Dates and times Check the prompt line above the type-in box for the scale’s preferred for-
mat. KeyCollect will accept any unambiguous response in the same 
month/day/year or hour/minute/second order as the scale structure.

Patterns The underlying structure of a pattern is one of the three Written Answer 
formats (short, short multiple, long unique). KeyCollect’s strictness on the 
entry (allowing spaces, etc.) depends on the definition of the pattern.

Short, countable written 
answers

Type in the response, up to 200 characters (the prompt line will let you 
know how much space you’ve used). If it is a multiple answer scale, use a 
semicolon “;” to separate distinct responses such as “cat; dog.” The 
Answer list will display up to 64,000 unique responses, which you can 
select by clicking. Short countable written answers are always one line, so 
Enter will drop you to the next field.

Long/unique written 
answers

Long/unique answers may be up to 10,000 characters, and as with short 
written answers the prompt line will keep track of your capacity. Normally 
long written answers allow multiple paragraphs, but they can also be set 
to Single Line for shorter unique answers such as names.
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Questionnaire for New Forms

Accessed from the Edit menu.

When a project contains multiple questionnaire versions, KeyCollect 
needs to know which document to use when entering new forms. This 
dialog allows you to select the questionnaire for entry, and will not affect 
your ability to view or edit any existing forms.

Double Entry with Verify

Verify provides a way to enter forms a second time, then have KeyCollect 
display any discrepancies to be corrected if needed. By entering a second 
time, preferably by a different person, the odds of making exactly the 
same operator entry error twice are small, leading to a high probability of 
getting the corrected entries exactly right. Verified forms can be protected 
against further changes.

Procedure

When the forms are first entered into the file, be sure to note which form 
number is assigned by KeyCollect. This will be required to match the 
paper questionnaire up with the computer’s forms later. It will also help to 
keep the paper forms in neatly ordered piles in case a form number is not 
written down sometimes.

To start verify open the .SDE file in KeyCollect if it is not already open. 
Starting a new KeyCollect session is normal when a different person han-
dles the re-entry.
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Confirm that Edit, Protect Answers are set as desired to allow the verify 
operation and usually to protect previously verified forms (verify will skip 
over any protected forms):

Step to the first form to be verified in this pass. It must be a paper form 
and not a protected form.

Select the menu Database, Start Verify Re-Entry which will bring up the 
dialog on the next page.

At the top is a multiple-selection list of all the questions in the question-
naire, where by default all the questions are selected. You can verify a sub-
set by using the control key with a left mouse click to turn items on or off 
individually, or use the Select All or Clear All. At least one question must 
be selected.

The Forms Management section reminds you that verify will start at the 
current form, stepping forward through all forms using the same paper 
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questionnaire layout as the first one. If any forms are protected it will say 
those will be skipped over too.

You can do the verification two ways:

• Form-by-form where you re-enter a form, then correct any 
mismatches, then go to the next form until the file is completed.

• Batch where you do the re-entry of a batch of forms in one pass, and 
then do a correction pass. This choice includes a selection of the 
batch size which will alternate between re-entry and correction until 
the file is done.

There is no need to set an ending form number because the menu Data-
base, Stop Verify lets you halt the session anytime you wish.

Once you have the setup dialog ready and click ok the form will have 
show the data entries of all the setup’s selected questions in green. These 
are the ones to be re-entered from the original paper master. When you 
have the re-entries complete click the next form button. What happens 
here depends on whether it is batch more or not; see below.

When a form is presented for correction one or more questions will have 
a red data entry area with the original answers set. These are the ques-
tions where the first and second entries disagreed in value (case-indepen-
dent for written answers). Either leave them alone or change to fit the 
paper form.

Note: you cannot go back to the previous form in verify mode.

Form-by-form

On next form from re-entry, if there were discrepancies it will give this 
notice:

Clicking ok shows the mismatched questions in red.

If there were no discrepancies you will get a different notice:
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Clicking ok here goes to another form for re-entry. This will be the next 
form with the same questionnaire that is not protected.

Batch

As you do the re-entry it will step to the next form just like normal entry 
until it reaches the end of the batch when this notice pops up:

This dialog tells you several things:

• It has gotten to the end of a batch (10 forms in this example)

• The first form in the batch was skipped because it did not have any 
problems to resolve

• The form to be presented for correction is number 7 with 1 mismatch.

Note there are two types of form numbers in the last sentence of the dia-
log: the count within the batch (2) and the number assigned in this data 
file (7). Since everything is tied back to form number this is why it is essen-
tial to number the paper forms as they are entered so you can find the ones to be 
corrected later.

When ok is clicked form 7 appears with the mismatches in red. Clicking 
the next form button after corrections will show a notice like the one 
above for the next problem form if any, or it will let you know the batch is 
done.

When the batch corrections are done, KeyCollect will either switch back 
into verify re-entry mode to continue with the next batch or end the verify 
session.
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Chapter 4
Editing Forms

Forms can be edited individually as needed, or using mass replace tools 
to consistently code responses. 

Understanding Data Cleaning

So what is data cleaning, why do you need to do it, and why doesn't 
SurveyPro do it automatically?

Data cleaning exists because usually we're happy if respondents complete 
the survey—reading the instructions is icing on the cake. 

When you receive forms with dates in the wrong format, rankings that go 
“1, 2, 2, 4, 5,” or “Wash” when you're using 2 letter state abbreviations, 
you're looking at data cleaning. Because it is a normal part of the survey 
process, KeyCollect includes a suite of tools both for minimizing and per-
forming data cleaning.

Questionnaire Definition

The place to start is with a well-designed survey. 

Make sure your scales have the proper structure for single/multiple 
answer checkboxes, date scales, etc. Questions should include clear 
instructions about how you'd like respondents to answer. Make sure skips 
and branching are explicit for paper forms, and properly constructed for 
DirectCollect and NetCollect.

Publish

If you are conducting the survey with a DirectCollect or NetCollect form, 
most potential problems can be caught while the respondent is complet-
ing the form. Do make sure the checks are enabled in the Publish dialog 
and properly tested, though. Also, while your instructions may not need to 
be quite as detailed as for paper forms, you still need to tell respondents 
what you want so they're not frustrated by unnecessary error messages.
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Import

Every KeyCollect import into SurveyPro has the option of cleaning the 
data. This includes whether you'd like to enforce pattern scales (such as 
telephone numbers), required answers, and passwords. Responses which 
do not match a set format, such as a date or number scale, are brought up 
for manual correction. This cleaning pass is usually the fastest way to cor-
rect entries, so even if you're in a hurry to see your results, we strongly 
recommend taking a couple minutes to perform the scan at this point.

Answer Entry

Both SurveyPro and KeyCollect's data entry screens will pick up your 
questionnaire structure and enforce the entry rules as new forms are 
entered.

For existing forms, there are several tools available. Use the Cleaning dia-
log under the Tools menu to perform a scan similar to import's (see page 
16). Manual corrections are facilitated by the Find commands under the 
Form menu. Find Form Select uses a filter (see page 25) which has great 
flexibility; Find Same Answers looks for matches to the current question's 
response; Find Duplicates lets you locate copies of either a complete form 
or a single answer. Finally, the Database menu has the ability to Mass 
Delete forms (see page 22), Mass Replace answers (see page 21), or 
Replace Answers within a single question (see page 19). 

Analysis

If for some reason you want to exclude forms which are incomplete or 
have other problems from your analysis, use Form Select Filters or Report 
On in SurveyPro.

Data Cleaning Dialog

Accessed from the Tools menu.

This dialog is very similar to the ones during import, and allows you to 
manage your database after collection. If you're new to data cleaning or 
KeyCollect, you may want to start with the overview on page 15.

The options in the lower half of the dialog depend on the structure of the 
selected question or grid, so if you don't see an option you need, check 
your scale definition. Questions which don't have a screen indicated in the 
first column will be ignored when you click Apply and Clean. Must 
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Answer is the only one which applies to all question types—the other con-
trols are covered further down this page.

Screens column The first column lists the “test” which will be performed on the data, such 
as a password screen or pattern check for an ID.

Must Answer Question Must answers are the only universal settings, and are absolute, so they 
should generally only be used when the form is invalid without an answer.

Cleaning Navigator

Once you click Apply and Clean, this navigation palette will pop up:

To jump to a matching record, just click on a form number in the list. Click 
Setup to bring the main dialog back, and Refresh to update the form list 
after you make edits.
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Checkbox and Rating Scales

For multiple answer checkbox scales, you can specify a minimum or max-
imum number of boxes which can be selected:

Written Answer and Pattern Scales

For each import there can be only one password field, whether it's a single 
value or file.

In addition, pattern scales can be enforced or loosened to allow data 
through.

Spell Check Dialog

KeyCollect checks the spelling of all written responses in a single form, or 
your entire data file. 

The Options dialog is where you decide what you want the spell checker 
to ignore, whether it's e-mail addresses or specific words you add to your 
dictionary. By default, all the words you add in the spell check dialog go 
into your system's custom dictionary (which you need to create to enable 
the Add button), but you can also exchange dictionaries with co-workers 
for sharing industry-specific terms.
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If you know of a set of words you'll need to use, or would like to edit the 
words you've added, select the custom dictionary you want to modify and 
click Edit. You can type in this dialog as a simple list, adding, changing, or 
removing entries.

Answer Replace

Accessed from the Database menu.

Answer Replace literally replaces one answer with another within the 
same question. Mass Replace can also do this, but takes a little longer 
since it's geared for more complex replacements (see page 21). 

The most common application is consistently coding short written 
answers for tabulation, such as replacing instances of “Wash” with “WA.” 
However, it can be applied to any scale type, not just text. You can also 
replace just one answer within a multiple answer checkbox or written 
scale.
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To replace answers, just select the question in Answer Entry mode, then 
select Answer Replace from the Database menu. You'll be provided with a 
list of all current responses, and can use Ctrl+Click or Shift+Click to 
select multiple answers to replace. The value you use to replace can be 
either from the drop-down list or click Type Answer to add a free-form 
response. 

After clicking OK, you'll see a confirmation dialog and then a message 
indicating the number of replacements.

Select Answer(s) List of all current responses to the question. To access Other blank 
entries, you have to select the Other blank itself, not the block of check-
boxes.

Change to this answer List of current responses from which you can select a replacement 
answer. For type-in scales (written answers, dates, etc.) you can click Type 
Answer to add a new response.

Type Answer Toggles the drop-down list to a type-in field and back. Only appears for 
written, date, number and pattern scales.

Update all Answer 
Reference lists

Updates the answer list for the current question when you finish the 
replacements. Generally you will only want to disable this if you are doing 
repeated replacements on the same question in a very large database.
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Mass Replace

Accessed from the Database menu.

Mass Replace changes the answer to a question in forms which match 
your selection criteria, whether it's for the entire database or a complex 
filter. However, if all you want to do is a simple replacement of one answer 
for another, you can use the Answer Replace setting, also under the Data-
base menu. This is a permanent operation, so we recommend cre-
ating a backup before beginning.

For these forms Select the entire database, a range of form numbers, or use a Form Select 
Filter (see page 25) to target forms with specific answers.

Replacing Select the question whose answers you'd like to replace, and type the new 
response. Mass Replace bases its replacements on the form selection 
above, not the current contents of the question (unless you base your 
selection filter on them).

Confirmation

When you click OK, you'll be prompted with a confirming dialog. You can 
either update the forms one-by-one, update all at once, or cancel the 
operation.
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Mass Delete

Accessed from the Database menu.

Individual forms can be deleted one by one, but if you want to clear out a 
block of forms Mass Delete is the tool to use. You'll find Mass Delete 
inside Answer Entry, under the Database menu. This is a permanent 
operation, so we recommend creating a backup before beginning.

For these forms Select the entire database, a range of form numbers, or use a Form Select 
Filter (see page 25) to target forms with specific answers.

Action Delete removes a form completely, renumbering the remaining forms. 
Void leaves a placeholder for the form number but removes all the data.

Confirmation

When you click OK, you'll be prompted with a confirming dialog. You can 
either delete the forms one-by-one, keep them, delete all at once, or can-
cel the operation.
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Chapter 5
Tools and Options

In addition to the Options you may use to streamline data entry, there are 
also some utilities which are useful for selecting forms (see page 25), pro-
tecting responses (see page 27), printing copies of answers (see page 28) 
or adding passwords or IDs to responses (see page 28).

Options Dialog

Most of the options apply to the file currently open. They are retained 
during Save and Save As operations.

Data Q# and Report 
numbering

If you have multiple questionnaire documents, you can select the question 
numbers referenced in reports.

Automatically delete 
questions

Behind your questionnaire(s) is a master database which normally 
matches your survey's content. By default, SurveyPro deletes questions 
which do not contain data when they are removed from all question-
naires, but you can turn off this option to keep the question for future use.
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Ask tile insert rules When you have multiple questionnaire documents, inserting new ques-
tions involves a prompt for whether you want to add the tile to all ques-
tionnaires or just that one survey. At the bottom of that prompt dialog is 
an option to stop asking—this setting turns the prompt back on.

Do not require Enter key To speed data entry, you can have KeyCollect automatically drop to the 
next question after entering an answer to single-digit scales.

Auto-increment Select a question to automatically increment as you enter new forms. The 
question must have a number scale.

Go to next form After the last field is entered on a survey, Tab will take you to a new form 
when this is enabled.

Date/Time on new forms Switch the format for KeyCollect’s internal date/time stamp from Ameri-
can to European.

Password Change Control By default, KeyCollect files are open for any editing. The first level pass-
word prevents unauthorized users from making edits to the questionnaire 
or the password settings. You can then add passwords which will restrict 
data entry/import, and reporting. 

When a protected file is opened, it has these areas locked using the setting 
in the Edit menu. To unlock, click on the area, and enter your password.

Note that your internal LAN security can be used to protect entire files 
from access by unauthorized users.

Allow more than one tile in 
a questionnaire

Normally, when you copy and paste a question within one document, the 
pasted tile is added as a new field in the database. In some advanced sur-
vey designs, you may want the same question (by Q#, not just visible text) 
to appear more than once in the survey. Be certain the multiple locations 
are exclusive skip paths, as any later instance of a question for one 
respondent would overwrite the original instance.
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Session Startup Default 
Directory

Sets the default for SurveyPro to look for and save data files.

Switch during session to 
last

Has SurveyPro look wherever you were last working for imports, exports, 
graphics, and new files. With this off, SurveyPro will look first in the 
default directory.

Automatic file save Has SurveyPro save automatically at an interval you specify. The warning 
notification will appear just once per session, not per file.

Enable document editing 
undo

If you do not use the Undo function, disabling it might enhance Survey-
Pro's performance. However, before turning off Undo, try closing any doc-
uments you’re not actively editing as this also speeds file changes. With a 
newer system with sufficient RAM, you will rarely need to turn off Undo.

Form Select Filters

Form Selects are used any time you want to look at a sub-set of forms 
while data cleaning (see page 15).

While filters can be manually constructed using the type-in box on the 
left, the easiest approach is to have SurveyPro build it. To create the AND 
rule in the screen capture below: 

1. Select the first question, Q21 from the drop-down list

2. Click = Equal

3. Select checkbox 1, Small Business

4. Click the button labeled Insert on the left hand side
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5. Click AND to add the parentheses

6. Select the second question, Q20

7. Click >= Greater-Equal

8. Select checkbox 4, $400-599

9. Click your mouse inside the second set of parentheses

10. Click Insert

You'll find it takes longer to read these instructions than to create the rule 
itself. If you create complex rules with many ANDs and ORs, be very 
careful to check your parentheses.

The Test Rule button is always a good idea to check your syntax and see if 
you're getting about the right number of forms.

Name Filter names can be up to 200 characters, though shorter is usually better.

Selection Rule The actual specification of what forms to find. Rules can be created or 
edited by hand, but generally it's easiest to build them with the right-hand 
panel.

Test Rule Provides either the number of forms it found or an error statement if it has 
a problem with the rule's syntax.

And/Or Add parentheses around the existing rule, the word AND or OR, and an 
empty set of parentheses at the end of the rule. Depending on the rule you 
are constructing, you may need to adjust the parentheses.
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Insert Transfers the rule you constructed on the right-hand side into the text 
box. If the Insert button is grayed out, you need to first click in the text 
box to tell it where to insert.

Pick a Question or Form 
Property

Lists the questions in the file, form attributes such as the date/time stamp 
or questionnaire, and any Form Selects you have already defined.

Rescale Applies a rescale to the question, handy if you have already grouped some 
checkboxes into categories, or dates and numbers into ranges. When a 
rescale is applied, it will read R7(Q3) in the rule, meaning the 7th rescale 
applied to the 3rd question.

Pick a Relationship Sets the relationship between the question or form attribute and the value. 
Equal Only == will pull a response which is exactly equal to the selected 
Value, and equal to no others (applies primarily to multiple answer check-
boxes and written answers).

Pick a Value Lists the values applicable to the selected question/rescale combination. 
Dates and numbers without a rescale will list the actual data. Written 
answers and patterns give you the option of displaying the whole Answers 
or extracting Keywords to fill the value list. Form Selects can be True or 
False.

Protect Answers

Accessed from the Edit menu.

Use this dialog to protect responses from accidental change. If you're 
interested in restricting access to editing, use the administrative pass-
words in the Options dialog (see page 23). 

Forms already verified Verification is a KeyCollect option where two different people enter forms 
to confirm accuracy, so this may not apply to your project. See Double 
Entry with Verify on page 11.

Prior session’s forms Sessions start with the launching of KeyCollect, and end when you exit.
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Other people’s forms KeyCollect prompts you for an ID when you launch the program. This ID 
is embedded in forms.

Warn before saving changes Pops up a confirmation warning when you leave a form which has been 
changed.

Print with Data

Accessed from the File menu in Answer Entry.

Print with Data allows you to merge database information into a question-
naire form. For example, you may want to do a mail merge where you 
place respondent names and addresses on the questionnaire, or to merge 
an ID into a barcode for scannable forms. Another application is printing 
respondents' answers in the context of the questionnaire.

The primary control in the dialog is your ability to select a range of 
forms—see Form Select Filters on page 25 for details on their construction.

Fill Passwords

Accessed from the Database menu.

This is a great utility for seeding a database with passwords. Just import 
your respondent contact information, adding a couple extras just in case. 
Make sure you have a question with a KeyCollect 4, 5, or all number PIN 
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scale. Then go to Answer Entry, Database Menu, and click Fill Passwords. 
KeyCollect will add passwords to any forms which don't already have 
them, checking to make sure the values are unique.

PIN files can also be generated from SurveyPro.
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Appendix A
License Agreements

YOUR AGREEMENT TO LEGAL CONTRACT:

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS 
BEFORE USING THE SOFTWARE. YOUR USE OF THE SOFTWARE 
INDICATES YOUR ACKNOWLEDGEMENT THAT YOU HAVE READ 
THIS LICENSE, YOU UNDERSTAND IT, AND YOU AGREE TO BE 
BOUND BY ITS TERMS AND CONDITIONS.   IF YOU DO NOT AGREE 
TO THESE TERMS AND CONDITIONS, RETURN THE SOFTWARE 
AND USER MANUALS TO THE PLACE OF PURCHASE WITHIN 30 
DAYS FROM THE DATE OF PURCHASE AS EVIDENCED BY A COPY 
OF A VALID RECEIPT AND YOUR PURCHASE PRICE WILL BE 
REFUNDED.

Chapter Contents: Single User License  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Workgroup (Multi-user) Site License  . . . . . . . . . . . . . . . . . . .  33
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Single User License
APIAN SOFTWARE LICENSE AGREEMENT for SurveyPro 4.0

SINGLE USER LICENSE

This Apian Software License Agreement (“License Agreement”) is a legal agreement 
between you and Apian Software, Inc. (“Apian”) for the use of Apian Software product pro-
grams and files identified above (“Software”). Software consists of the computer program, 
its accessory programs and included files, and may include associated media, printed 
materials, any “on-line” or electronic documentation and also includes any updates and 
supplements to the original Software provided to you by Apian. By installing, downloading, 
accessing, copying, or in any way using the Software, you agree to be bound by the terms 
of the License Agreement.

Ownership of Software, Copyright, Trademarks Retained

The Software is the property of Apian Software, Inc. The Software is protected by copy-
right laws and international copyright treaties, as well as other intellectual property laws 
and treaties. The Software is licensed, not sold. All rights not expressly granted are 
reserved by Apian.

Grant of License. Apian grants you the non-exclusive, non-sublicensable, limited license to 
use the Software so long as you comply with all the terms of the License Agreement for 
the Software use you have paid for.

Single User License. You may install and use this Software under a Single License as either 
(1) a PERSONAL Configuration or as (2) a SINGLE-USER SITE Configuration, but not 
both.

In a PERSONAL configuration you may install the Software wherever you are working, so 
long as it used by one individual and no other. You may install the Software in machine-
readable form on any computer(s), including on a network server, solely for one person’s 
individual use, and so long as no other person can access the Software. You may NOT 
allow more than one individual to use the Software at any time under this option.

OR

In a SINGLE-USER SITE configuration you may install the Software at a single Site. It may 
be used by any person who normally works at this site, so long as the Software is used by 
no more than one person at a time. You may install the Software in machine-readable form 
on one computer only (workstation or LAN server). The Software may be accessed by a 
person who normally works at the site on the one network server over a dial-up connec-
tion, Local Area Network, Virtual Private Network, or its equivalent where the program is 
executed directly from the single copy on that server.

You may not combine elements of the PERSONAL and SINGLE-USER SITE Options.

If you need the right for more than one person to use the Software, please contact Apian 
Software for Workgroup License information.

Backup Copy. You may make one (1) copy of the Software in machine-readable form solely 
for backup purposes, provided that you reproduce all proprietary notices on the copy.

Transfer of Software. You may transfer your rights in the Software one time, from you to 
one other person, provided you permanently transfer all rights under this Agreement, and 
not for the purposes of a single project or segment of a project.
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Limits on Modifications. You may not modify, translate, reverse engineer, decompile, dis-
assemble, create derivative works based on, or copy (except for the backup copy) the Soft-
ware or accompanying materials (except for sample code). You may not use or modify 
sample source code except as required for its use with licensed Apian Software products. 
You may not remove any proprietary notices, labels or marks on the software or accompa-
nying materials.

NetCollect Web surveys. You may install on any Online server(s) HTML surveys exported 
from NetCollect. Perl, ASP and other server application components included with Net-
Collect may be used with NetCollect HTML surveys by licensed users of NetCollect, but 
may not be distributed separately, reverse-engineered or used for other purposes.

DirectCollect surveys. You may distribute as many copies of the run-time survey data col-
lector and team interviewer modules as needed, or offer network access to them for 
respondents, without additional licenses. Visual Basic source code included with Direct-
Collect may be modified and used with DirectCollect by licensed users of DirectCollect, 
but may not be distributed separately, reverse-engineered or used for other purposes.

KeyCollect. You may install as many copies of the KeyCollect accessory program as you 
wish for data entry to SurveyPro projects developed under this license.

Respondent EMailer. You may install as many copies of the Respondent EMailer accessory 
program as you require to support SurveyPro projects developed under this license. The 
Respondent EMailer is not licensed or supported for general use. Apian supports responsi-
ble bulk mailing. The Respondent EMailer may be used only for mailings which comply 
with: current “Spam” or Unsolicited Bulk E-mail legislation, Acceptable Uses or similar 
contractual obligations you may have with your Internet service provider(s) and opt-in 
mailing lists.

Evaluation Software. Software identified as “Evaluation” or “Demonstration” may not be 
resold, transferred or used for any purposes other than demonstration, test, or evaluation.

Upgrades and Conversions. If the Software is an upgrade of an earlier release, a conver-
sion from another Apian Software product, or fulfillment of a Beta Subscription, then you 
must cease using all earlier versions except for transitional use during the upgrade. You 
may not loan, rent, sell or otherwise transfer any earlier version. This license agreement 
replaces all prior license agreements effective with installation of the Software, and prior 
Licenses for earlier versions are hereby terminated. Following installation, the Entire 
agreement of both parties is governed by the terms of this current license agreement, 
which supersedes all earlier versions.

Termination of License. Unauthorized copying of the Software (alone or merged with other 
software) or the accompanying materials, or failure to comply with the restrictions in the 
License Agreement automatically terminates this License Agreement. Upon termination 
of the license, you must remove the Software from all computers on which it is installed, 
and destroy or return to Apian the Software, accompanying materials, and any copies 
made by you.

Limited Warranty and Disclaimer. Apian Software, Inc. warrants the media on which the 
Software is furnished to be free of defects in material and workmanship under normal use 
for a period of ninety (90) days from the date of delivery to you as evidenced by a copy of 
your receipt. If any media does not conform to this limited warranty, your exclusive rem-
edy is replacement of the media or, if Apian is unable to deliver replacement media, refund 
of the purchase price and termination of the License Agreement.

NO OTHER WARRANTIES. EXCEPT FOR THE ABOVE WARRANTY, THE SOFTWARE 
AND ACCOMPYING MATERIALS ARE PROVIDED WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS, IMPLIED, STATUTORY, IN ANY COMMUNICATION WITH 
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APIAN SOFTWARE, INC., OR OTHERWISE, INCLUDING WITHOUT LIMITATION 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. APIAN SOFTWARE, INC., DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTRRUPTED OR ERROR FREE. 
THE ENTIRE RISK AS TO THE USE, QUALITY, AND PERFORMANCE OF THE SOFT-
WARE IS WITH YOU.

SOME STATES DO NOT ALLOW EXCLUSION OF IMPLIED WARRANTIES SO THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU.   THIS LIMITED WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM 
STATE TO STATE.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICA-
BLE LAW, APIAN SOFTWARE, INC., SHALL IN NO EVENT BE LIABLE FOR ANY SPE-
CIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE 
SOFTWARE OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, 
EVEN IF APIAN SOFTWARE, INC. HAS BEEN ADVISED OF THE POSSIBLITY OF 
SUCH DAMAGES. IN EVERY CASE, APIAN SOFTWARE, INC.’S MAXIMUM LIABILITY 
UNDER ANY PROVISION OF THE LICENSE AGREEMENT SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE OR USD $5.00, 
WHICHEVER IS GREATER.

General. This agreement will be governed by the laws of the State of Washington. Any suit 
regarding this License shall be brought only in King County, Washington. This Agreement 
is the entire agreement between us and supersedes any other communications with 
respect to the Software and accompanying materials. If any provision of this Agreement is 
held unenforceable, the remainder of this agreement shall continue in full force and effect.

U.S. Government Restricted Rights. Government Use. The Software and accompanying 
documentation are deemed to be “commercial computer software” and “commercial com-
puter software documentation,” respectively, pursuant to DFAR Section 227.7202 and FAR 
Section 12.212, as applicable. Any use, modification, reproduction, release, performance, 
display or disclosure of the Software and accompanying documentation by the U.S. Gov-
ernment shall be governed solely by the terms of this License Agreement and shall be pro-
hibited except to the extent expressly permitted by the terms of the License Agreement.

If you have any questions, please contact the manufacturer in writing: Apian Software, 
Inc., 115 N 85th Street, Suite 204, Seattle, WA 98103.

Workgroup (Multi-user) Site License
APIAN SOFTWARE LICENSE AGREEMENT for SurveyPro 4.0

WORKGROUP SITE LICENSE for simultaneous users.

This Apian Software License Agreement (“License Agreement”) is a legal agreement 
between you and Apian Software, Inc. (“Apian”) for the use of Apian Software product pro-
grams and files identified above (“Software”). Software consists of the computer program, 
its accessory programs and included files, and may include associated media, printed 
materials, any “on-line” or electronic documentation and also includes any updates and 
supplements to the original Software provided to you by Apian. By installing, downloading, 
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accessing, copying, or in any way using the Software, you agree to be bound by the terms 
of the License Agreement.

Ownership of Software, Copyright, Trademarks Retained

The Software is the property of Apian Software, Inc. The Software is protected by copy-
right laws and international copyright treaties, as well as other intellectual property laws 
and treaties. The Software is licensed, not sold. All rights not expressly granted are 
reserved by Apian.

Grant of License. Apian grants you the non-exclusive, non-sublicensable, limited license to 
use the Software so long as you comply with all the terms of the License Agreement for 
the Software use you have paid for.

Workgroup Site License. If you have purchased use of the Software under a Workgroup 
License, you may install the Software in machine-readable form for use at a single site. A 
Workgroup License is limited to a specified number of simultaneous users (the number of 
which is specified at the top of this license and is controlled and/or monitored by a serial 
number placed within the master disk provided to you) who work at one site. A Workgroup 
License does not allow the Software to be installed at more than one physical site. The 
Software may be shared subject to these limitations by the licensed users in one of the 
ways outlined below.

You may:

   1. Install the Software in machine-readable form, on one server and/or one or more 
independent computers (not exceeding the total number of licensed simultaneous users) 
at one site. Users who normally work at the site may access the Software on the one net-
work server over a dial-up connection, Local Area Network, Virtual Private Network, or its 
equivalent where the program is executed directly from the single copy on that server;

   2. Allow up to the number of licensed users who work at one site to use the Software at 
one time; and

   3. Physically move the Software from one computer to another, provided the Software is 
installed on no more computers than, and used by no more than the number of licensed 
users at one site at any one time.

Backup Copy. You may make one (1) copy of the Software in machine-readable form solely 
for backup purposes, provided that you reproduce all proprietary notices on the copy.

Transfer of Software. You may transfer your rights in the Software one time, from you to 
one other person, provided you permanently transfer all rights under this Agreement, and 
not for the purposes of a single project or segment of a project.

Limits on Modifications. You may not modify, translate, reverse engineer, decompile, dis-
assemble, create derivative works based on, or copy (except for the backup copy) the Soft-
ware or accompanying materials (except for sample code). You may not use or modify 
sample source code except as required for its use with licensed Apian Software products. 
You may not remove any proprietary notices, labels or marks on the software or accompa-
nying materials.

NetCollect Web surveys. You may install on any Online server(s) HTML surveys exported 
from NetCollect. Perl, ASP and other server application components included with Net-
Collect may be used with NetCollect HTML surveys by licensed users of NetCollect, but 
may not be distributed separately, reverse-engineered or used for other purposes.

DirectCollect surveys. You may distribute as many copies of the run-time survey data col-
lector and team interviewer modules as needed, or offer network access to them for 
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respondents, without additional licenses. Visual Basic source code included with Direct-
Collect may be modified and used with DirectCollect by licensed users of DirectCollect, 
but may not be distributed separately, reverse-engineered or used for other purposes.

KeyCollect. You may install as many copies of the KeyCollect accessory program as you 
wish for data entry to SurveyPro projects developed under this license.

Respondent EMailer. You may install as many copies of the Respondent EMailer accessory 
program as you require to support SurveyPro projects developed under this license. The 
Respondent EMailer is not licensed or supported for general use. Apian supports responsi-
ble bulk mailing. The Respondent EMailer may be used only for mailings which comply 
with: current “Spam” or Unsolicited Bulk E-mail legislation, Acceptable Uses or similar 
contractual obligations you may have with your Internet service provider(s) and opt-in 
mailing lists.

Evaluation Software. Software identified as “Evaluation” or “Demonstration” may not be 
resold, transferred or used for any purposes other than demonstration, test, or evaluation.

Upgrades and Conversions. If the Software is an upgrade of an earlier release, a conver-
sion from another Apian Software product, or fulfillment of a Beta Subscription, then you 
must cease using all earlier versions except for transitional use during the upgrade. You 
may not loan, rent, sell or otherwise transfer any earlier version. This license agreement 
replaces all prior license agreements effective with installation of the Software, and prior 
Licenses for earlier versions are hereby terminated. Following installation, the Entire 
agreement of both parties is governed by the terms of this current license agreement, 
which supersedes all earlier versions.

Termination of License. Unauthorized copying of the Software (alone or merged with other 
software) or the accompanying materials, or failure to comply with the restrictions in the 
License Agreement automatically terminates this License Agreement. Upon termination 
of the license, you must remove the Software from all computers on which it is installed, 
and destroy or return to Apian the Software, accompanying materials, and any copies 
made by you.

Limited Warranty and Disclaimer. Apian Software, Inc. warrants the media on which the 
Software is furnished to be free of defects in material and workmanship under normal use 
for a period of ninety (90) days from the date of delivery to you as evidenced by a copy of 
your receipt. If any media does not conform to this limited warranty, your exclusive rem-
edy is replacement of the media or, if Apian is unable to deliver replacement media, refund 
of the purchase price and termination of the License Agreement.

NO OTHER WARRANTIES. EXCEPT FOR THE ABOVE WARRANTY, THE SOFTWARE 
AND ACCOMPYING MATERIALS ARE PROVIDED WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS, IMPLIED, STATUTORY, IN ANY COMMUNICATION WITH 
APIAN SOFTWARE, INC., OR OTHERWISE, INCLUDING WITHOUT LIMITATION 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. APIAN SOFTWARE, INC., DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTRRUPTED OR ERROR FREE. 
THE ENTIRE RISK AS TO THE USE, QUALITY, AND PERFORMANCE OF THE SOFT-
WARE IS WITH YOU.

SOME STATES DO NOT ALLOW EXCLUSION OF IMPLIED WARRANTIES SO THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU.   THIS LIMITED WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM 
STATE TO STATE.
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LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICA-
BLE LAW, APIAN SOFTWARE, INC., SHALL IN NO EVENT BE LIABLE FOR ANY SPE-
CIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE 
SOFTWARE OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, 
EVEN IF APIAN SOFTWARE, INC. HAS BEEN ADVISED OF THE POSSIBLITY OF 
SUCH DAMAGES. IN EVERY CASE, APIAN SOFTWARE, INC.’S MAXIMUM LIABILITY 
UNDER ANY PROVISION OF THE LICENSE AGREEMENT SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE OR USD $5.00, 
WHICHEVER IS GREATER.

General. This agreement will be governed by the laws of the State of Washington. Any suit 
regarding this License shall be brought only in King County, Washington. This Agreement 
is the entire agreement between us and supersedes any other communications with 
respect to the Software and accompanying materials. If any provision of this Agreement is 
held unenforceable, the remainder of this agreement shall continue in full force and effect.

U.S. Government Restricted Rights. Government Use. The Software and accompanying 
documentation are deemed to be “commercial computer software” and “commercial com-
puter software documentation,” respectively, pursuant to DFAR Section 227.7202 and FAR 
Section 12.212, as applicable. Any use, modification, reproduction, release, performance, 
display or disclosure of the Software and accompanying documentation by the U.S. Gov-
ernment shall be governed solely by the terms of this License Agreement and shall be pro-
hibited except to the extent expressly permitted by the terms of the License Agreement.

If you have any questions, please contact the manufacturer in writing: Apian Software, 
Inc., 115 N 85th Street, Suite 204, Seattle, WA 98103.
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patching SurveyPro 2
pattern scales 10, 18
pencil buttons 7
PIN 28
Preferences 23
Print 4
Print with Data 28
Protect Answers 27

R
ranking scales 10
rating scales 10, 18
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Save 4
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support 1
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T
technical support 1
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